
  

Running DJSWIFT

 Phase reference
 Gain check
 Acquire
 Reconstruct



  

Make sure the coil and sample are set up and tuned to 3mhz or greater FWHM 
(full width half max) of the resonance.  Here we are using a sweep generator to 
verify the tuning. Other options are to use a network analyzer or Vnmrj with 
mtune (a sweep generator mode).

Tune Coil and Sample



  

VnmrJ starts up.  Verify you have a signal using SPULS or similar sequence.

Start VnmrJ



  

In the experiment selector, click on the CMRRpack tab header.

Select CMRRpack in experiment selector



  

Click on djswift_4T down arrow on the left side of the CMRRpack tab.
Select djswiDD_phaseref_autotof_4T from the drop down menu.

Load Phaseref sequence



  

In the study queue menu below, double-click on djswiDD_phaseref_autotof_4T 
study. This will load the SWIFT panel and pulse sequence.

Load Phaseref sequence (con’t)



  

Click on the nogo button. This computes tables in vnmrsys/tablib needed for the 
sequence to run. If you update parameters such as LRO or LPE, a nogo is 
needed to see the recomputed tables and parameter changes before running. A 
nogo is also done as part of Start Scan.

Compute tablib tables with “nogo”



  

Make a scout scan for planning the SWIFT field of view. One way to do this is to use the SCOUT 
sequence. Click on the 2D tabheader in the experiment selector and choose the SCOUT sequence. 
Clicking on SCOUT adds it to the study queue below. Double click on SCOUT to load this sequence.

After the scout scan, double click on the SCOUT entry in the study queue to load the scout slices in 
the Plan & Start viewport.

Do a SCOUT scan for planning



  

After the scout images show, double click on the djswiDD_phaseref_autotof_4T 
entry in the study queue to reload the SWIFT panel and sequence. The panel 
should be on the Acquire tab and the Scan subpanel selected on the left.

Reload the Phaseref sequence



  

Click on the word Plan on the left side to bring up the Plan subpanel.
This is very similar to the Agilent planning panel.

Switch to the Plan subpanel



  

Change entries in the FOV section. Make a small field of view (example 50, 50, 
50, offset 0, 0, 0) and choose Axial90 orientation to update the Plan & Start 
window with the small FOV at isocenter.

Drag the small FOV rectangle to the center of your desired phaseref field of 
view.

Choose your FOV



  

Enter values for the FOV large enough so that it is at least twice as large
as the largest dimension of the object. The FOV rectangle may not be visible
after this if it is larger than your original scout image. Change to back the Axial 
orientation.

Expand your FOV



  

In the command window, type “cc_update_from_rx” to invoke the macro.
This will transfer the offset values to the POS1, POS2, POS3 values on
the Scan page FOV section. (We have this macro hooked to a toolbar
button called "rx".) If successful, the macro will respond "SWIFT trans volume 
plan updated".

Update FOV parameters POS1, POS2, POS3



  

Switch back to the Scan page. Notice that the FOV and POS1, 2, 3, values have been updated, but 
note that the values on this panel are displayed in cm rather than mm.

Now hit Start Scan (green) to acquire the phase reference. You will see "acquisition complete" and 
"data saved" messages. The SWIFT sequence is now displayed in the viewing area.

Acquire for Phaseref



  

You can find the name of the data directory on the Start tab Subject Info page, 
next to Data will be saved in...

Note location of data folder



  

Now open a remote session to run the grid3p3 Labview executable. It is 
preferred to run this Labview executable remotely because of the memory and 
CPU required. We use VNC to do this. Another optionis ssh (forwarding X-
windows with the -Y or -X options).

On the remote system, open a terminal window and run the program. You will 
have installed grid3p3 on the remote system under a vnmrsys/cmrr directory.  

In our case, we have a shared directory over NFS and are running the 
executable installed on the console. The shared NFS directory also allows the 
executable to access the data that was just acquired.

cd
cd vnmrsys/cmrr/bin
./grid3p3_plus_dicom_daemon

A number of windows will first open and then be hidden. You will see the file 
selection dialog.

Start grid3p3 on remote system



  

The default directory opened is vnmrsys/data. Select the study folder just created. Double click on the 
study folder, then select the fid file for the phaseref and click Select. In this case it was 
data/20120808_01/djswDD_phaseref_autotof_4T_62500_os4_ap0_76cm_01.fid

Parts of the fid directory name may be replaced with automatic values (which is customizable via 
Vnmrj file save data setup dialog).

Open the Phaseref fid



  

The window display_graph.vi will open. The upper left shows imaginary (by default), the upper right 
shows the real, and the lower right shows the phase of the average projection.

You can change what the upper left graph shows by using the display menu on the left. By default it 
shows the imaginary component. The average projection is an average of all the available data. 

grid3p3 displays the average projections



  

You can display more detail by clicking on the Collapse button. With collapse 
on, the average is displayed (single line). With collapse off, a number of 
individual projections are displayed.

grid3p3 projection option - Collapse



  

Click on the auto phase button. The program will recalculate the phase and 
redisplay the average projections and phase graphs. Under ideal conditions (no 
coil ringdown, no short T2 background, and homogenous/uniform B1), this is all 
that is needed. The auto phase works from the average projection (the 
"collapsed" line).

grid3p3 auto phase



  

The default values used for the auto phase are displayed next to the auto phase 
button.  The value in start phase calc and length phase calc are used to 
calculate the phase when you click auto phase.  The default value of "350" 
should work well. If these values are out of range of your data, you may get
"not a number" or other errors. Adjust these as needed to fit your data.

To further fine tune the phasing, there are two phase parameters to adjust, lp 
and rp.  For this sequence, an lp value of "-90" works well. A rp value will 
depend on your coil, cabling, etc.  In our case, a value of "-31" or "-32" results in 
an average projection in the real display with a desirable charateristic shape.

The desired graph shape has the property that data related to the object is 
displayed in the middle of the graph and is surrounded by a relatively symmetric 
baseline. The slope change from the baseline to the object part of the graph will 
be roughly symmetrical on both sides of the object. You can tune the shape by 
changing the values of lp and rp.

To change the values of lp and rp, you can enter values into the text boxes, use 
the up and down arrows, or use the sliders. Changing these values will 
automatically recalculate the phase and redisplay. 

Clicking auto phase will return to the default calculation.

grid3p3 phase adjustments



  

You might also want to click on the collapse button (turn off collapse) to display 
additional projections, and watch the black line in the graph as you tune the 
phase parameters. 

Once you have finished tuning the phase, click on the Done button.

grid3p3 phase adjustments (con’t)



  

If you have multi-channel data, additional display_graph.vi windows will appear, one at a time. (The 
channel number will not appear.) You can tune the phase for each channel individually. Ordinarily, the 
lp parameter will remain the same, and the rp will need to be adjusted.

Continue to adjust the phase and click Done for each channel until the phase is tuned for each 
channel.

grid3p3 Phase tuning additional channels



  

At this point, grid3p3_matlab window will open and a reconstruction will start. 
This is not useful during phase tuning, and should be canceled.

grid3p3 Cancel reconstruction during phase tuning



  

To cancel this reconstuction, close the grid3p3_matlab window by clicking in the 
upper right corner. Labview may display an error window when you do this. 
Click on "Stop" button in the Labview error window if this happens.

grid3p3 Cancel reconstruction during phase tuning (con’t)



  

At this point, you have set good phase values in rp array and lp array. These 
are displayed in the lower right corner of the grid3p3_chunks.vi window.

grid3p3 Phase values set



  

Return to the Vnmrj window. In the experiment selector, choose the CMRRpack tab. On that tab, click 
on the djswift_4T down arrow on the left and select the djswiDD_gaincheck_autotof_4T option from 
the dropdown menu to load it into the study queue.

Double-click djswiDD_gaincheck_autotof_4T in the study queue to load the gaincheck protocol.

Load gaincheck sequence



  

Once the gaincheck protocol is loaded, right-click on the phaseref protocol in 
the study queue and select "Copy Volume Plan".

After doing this, in the command window type "cc_update_from_rx" macro to 
update the POS1, 2, 3 fields.  As before, the macro will respond with "SWIFT 
trans volume plan updated".

Copy plan values to gaincheck



  

Click on the Acquire,Plan page and adjust the FOV parameters again to your 
desired field of view that includes all the object signal. Previously the phaseref 
was set to a larger FOV. Here the gaincheck will have a smaller FOV.

You should set the flip angle flip1 to the desired value before adjusting the gain.

Set gaincheck FOV



  

At this point, return to the Acquire,Scan page and click Start Scan (green).

You will see acquisition complete, data saved in the command window. In the 
study queue, you will see gaincheck... Done.

Acquire first gaincheck



  

Now click on the Current Scan button in the upper right (next to Plan & Start) to 
switch to the current scan viewport. In the command window, type "djgain".

Run djgain macro to check data range



  

The first djgain is run using a gain value of "0". This value is on the Acquire,Scan page on the middle left side. 
djgain will display its results with "actually used" values. These are real, imaginary values in A/D units. A valid 
target value for the real component of "actually used" is about 5000-9000 with an optimal value of about 8000.

To adjust this value, change the gain value on the Acquire,Scan page. The gain value affects the "actually 
used" values in a logarithmic fashion. Increasing the gain value by "6" should adjust the "actually used" 
values by 2x, while increasing the gain value by "20" should adjust those values by 10x.

Adjusting the gain



  

You may want to add a comment in the comment field in the Commands area 
to note this change. Here we add the comment "gain6". Once you have 
adjusted the gain value, click on Start Scan (green).  You will see another study 
entered into the study queue with your comment (in this case "gain6").  When 
complete,
you will again see Data saved, gaincheck done in the messages window.

Rechecking the gain – comment and reacquire



  

After reacquiring, return to the Current Scan window, type "djgain" in the 
command window, and observe the change in "actually used" A/D values. 
Repeat as needed to achieve "actually used" values near 8000.

Rechecking the gain – check data ranges



  

In the experiment selector, on the CMRRPACK tab, click on the djswift_4T 
down arrow on the left and select the djswiDD option from the dropdown menu 
to load it into the study queue. Then double-click djswiDD in the study queue to 
load the SWIFT protocol.

Load SWIFT sequence



  

Right click on the gaincheck protocol in the study queue and choose Copy 
Volume Plan as before. Run the cc_update_from_rx macro to update the 
POS1, POS2, POS3 fields.

Fill in the flip angle flip1 and the gain value you arrived at during the gaincheck. 
Optionally enter the same comment in the comment field.

Copy volume plan, flip angle, and gain from gaincheck



  

At this point, select the view order under the Misc section. Full view order "Nspir_full" is 
recommended for static high-resolution scans, while Halton view order 
"view_halton_nav64nosub_512_512_16_xx" is recommended for dynamic scans.

If you use full view order, also adjust Nspiral in the Acq section to the number of spirals desired and 
Nv to the number of views per spiral desired. The total number of views will be Nv * Nspiral. For 
Halton view orders, Nv and Nspiral are read from tables.

Select SWIFT view order



  

Click on Start Scan (green). The estimated time length of the scan is reported in 
the messages window and depends on the number of views selected.

At the end of the sequence you will again see Acquistion complete, data saved 
in the messages window.

Afterwards, or even during the sequence, you can run "djgain" from the Current 
Scan window in the command window to verify the values you have.

Note that receiver overflow LED on the Agilent/Varian monitor channel monitor 
may not be valid for SWIFT. (If it lights up, you can ignore it.) Use djgain values 
to determine receiver overflow instead.

Now return to the grid3p3_plus_dicom_daemon executable window.

Acquire SWIFT data



  

In the middle of the left side of the main window, click on the autophase, first 
spiral, and interactive phasing buttons to turn them off.

grid3p3 autophasing off



  

Now click on the Run button (right arrow on the upper LEFT side of the toolbar).

This will bring up the file dialog so you can load the data that you just acquired. 
It will open up in the directory where you last loaded data (in this case, the 
phaseref folder).

grid3p3 load SWIFT data



  

First navigate back up one level to the parent folder. Now select the djswiDD fid 
folder to reconstruct. The name is dependent on your Vnmrj configuration. Click 
on Select (not Open, Open will open that directory).

Data will load... this may take a moment or two. When loaded, the 
grid3p3_chunks.vi window will come to the front.

grid3p3 open SWIFT fid



  

When grid3p3_chunks.vi comes to the front, it will still be processing the first 
spiral. You will see the sinogram update when the first spiral is done.

There is a blue progress bar. Also, the spiral and channel index displays will 
update as the correlation proceeds.

grid3p3 correlation



  

After the correlation, a grid3p3_matlab window will open and the gridding will 
begin. It will do 3 DCF iterations, forward grid, then FFT and shift, and then 
save the data file.

grid3p3 gridding



  

The matlab window will close automatically and the data will be converted to 
raw and dicom formats.

Afterwards you will be able to see the total recon time taken. This depends 
mostly on the system performance and size of the data set.

grid3p3 data conversion



  

You may now look at the reconstructed images with an appropriate viewing program. We use ImageJ. 
Another option we use is fiji. For ImageJ, start the program (which sometimes installs under Graphics 
in the system Applications menu).

To read the raw files, click on File -> Import -> Raw and navigate to the data folder you have been 
using. Inside the folder, the fid folder, and the sgl.d folder, you will find a 3d_mag.sgl file.

ImageJ opening raw data



  

This raw data file is of type 32-bit real, 256 x 256 pixel. The number of images 
must be larger than the number of slices. The number of slices in the file is 256 
by default.

ImageJ loading raw data



  

Here is an example of a displayed raw data set with ImageJ.

You can scroll to the image with signal, and then choose Image -> Adjust -> 
Brightness/Contrast and click Auto.

ImageJ viewing raw data



  

You can also File -> Import -> Image Sequence to load the dicom file. Navigate 
upwards to the MR1 folder. Double click on the MR1 folder and select the 001 
slice. The entire series will load. You can scroll to the image with signal and 
adjust the brightness and contrast as before.

ImageJ viewing dicom data
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